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1. Getting started 

1.1 Introduction 

 
Welcome to the IOSONO Spatial Audio Workstation. The Spatial Audio Workstation is more 
than just another surround panner. Multiple sound objects can be viewed and manipulated in 
a single surround editor window and multiple surround configurations can be created with 
the same automation data. It allows you to move sound in ways no other panning software 
can. This manual will describe how to use the Spatial Audio Workstation in creating 
compelling surround sound mixes that will translate to multiple speaker configurations.  
 
The Spatial Audio Workstation uses an object-based system to manipulate sound objects 
within the acoustic space experienced by the audience. Objects can be moved around the 
listening environment, regardless of the speaker configuration. The paths that objects move 
on can be precisely edited. The positioning and motion of sound objects can be created in any 
surround configuration and the detail of that motion will be retained on more complex 
playback systems. No other software can provide this type of translation between various 
speaker systems. With this ability, editors may create positioning and motion data that can be 
further refined during the mixing process in whatever format is required for delivery. 

1.2 System requirements 

 
The Spatial Audio Workstation plug-in runs in Steinberg’s Nuendo DAW software on Windows 
operating systems. The Spatial Audio Workstation’s sophisticated processing needs to be 
tightly integrated into the DAW to provide seamless usability to the user. Therefore the Spatial 
Audio Workstation is not a VST plug-in typical for Steinberg systems. It is a “program plug-in” 
as defined by Steinberg and, when installed, can be found listed in the Plug-in Information 
window under the Program Plug-ins tab.  
 
Recommended system requirements  

▪ Operating System: Windows 7, Windows 8/8.1, Windows 10 
▪ DAW host application: Steinberg Nuendo 10, Nuendo 8 (64 bit) or Nuendo 7.1 (64 bit), no 

support for 32 bit versions 
o Please note that Steinberg Nuendo 7.0, 7.1.0, 7.1.20, 8.2 do not work! 

▪ Processor: Intel Core i3/i5/i7, 2.4 GHz or faster 
▪ Sound card: ASIO driver, at least 6 output channels for standard surround production, up 

to 64 output channels for object-based production with external IOSONO processing 
▪ Display: Resolution 1920 x 1080 pixels or higher, dual screen 
▪ eLicensor USB dongle 

1.3 License Management 

 
The Spatial Audio Workstation license key needs to be activated and stored on an eLicensor 
USB dongle; preferably the same dongle that already contains the Nuendo license. Please read 
the eLicensor Control Center manual for instructions on how to activate licenses. 
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1.4 Installation 

 
Installation is straightforward. Just follow the instructions found in the Spatial Audio 

Workstation installer download. If you have multiple versions of Nuendo installed on your 

computer you must choose the correct program path. Nuendo should not be running during 

installation. When installation is completed, open Nuendo’s Devices menu and go to the Plug-

in Information. Click on the Program Plug-Ins tab to make sure that the Spatial Audio 

Workstation is listed there and is checked active. 

 

 

Note: Only activate or de-activate the Spatial Audio Workstation while no Nuendo project 

is open. 

 

 

Figure 1: Nuendo plug-in information window 

 
Once active, the Spatial Audio Workstation user interface is accessible from Nuendo’s Project 

menu. Select Show Window and the Spatial Audio Workstation will open up. The user interface 

requires a large screen area to be fully displayed without scrolling. Therefore a dual screen 

setup is highly recommended. The Spatial Audio Workstation window brings its own menu 

bar to organize the various functions and settings.  

1.5 Configuration  

 

The Settings menu found in the Spatial Audio Workstation window is used to configure the 

software for your particular surround speaker setup. The Settings menu has two options:  

 

 

▪ Project settings  

These settings are specific to each Spatial Audio Workstation project that you create and 

are saved with the project data in the Nuendo file (*.npr).  

▪ Preferences  
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These settings are global and are retained regardless of what Nuendo project is active.  

1.5.1 Project settings 

 
The Projects settings dialog offers the following options. 
 

 

Figure 2: Settings Dialog 

 
Internal processing (native rendering for legacy setups) 
 
The Active Bus Arrangement pull-down menu offers a number of surround speaker 

configurations. The selected configuration determines how the position of each sound 

object in Spatial Audio Workstation is rendered to the audio output channels of 

Nuendo. You can change the Active Bus Arrangement at any time without affecting the 

existing object automation. The format of the related VST Connections output bus is 

adjusted automatically. This allows you to work in several different surround 

configurations with no need for altering panning data and automation.  

 

External processing (rendering on external IOSONO hardware) 

 

By selecting this option the object-based sound scene created with Spatial Audio 

Workstation is transmitted in real-time to an external processing hardware and 

http://www.barco.com/
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rendered to a specific 3D loudspeaker setup. Supported spatial audio processing 

hardware is Barco AudioCue. 

 

Choose the appropriate scene protocol to communicate with the given spatial audio 

processor and configuration. 

 

▪ Vertical Pan – Barco AudioCue configured with multilayer loudspeaker setup 

▪ Generic 3D – Barco AudioCue configured with generic 3D loudspeaker setup 

 

By checking the Custom venue option you can load a loudspeaker setup file (*.ls3 or 

*.ls4) of a dedicated venue. If this file matches your current Barco AudioCue 

configuration you can position your sound objects in direct relation to the loudspeaker 

positions. Go to Spatial Audio Workstation’s View menu and select Show speakers to 

display the loudspeaker positions on the Stage view. The loudspeaker setup file will be 

stored within the Nuendo project file (*.npr). 

 

Background image  
 
For each project you can overlay the Stage view with a background image in .png and 

.svg format. This image must be centered and scaled to have the correct relationship to 

the grid defined in the Spatial Audio Workstation. The background image is stored 

within the Nuendo project file (*.npr) and will be visible when Show background image 

is selected from the View menu. 

 

Distant dependent volume and EQ  
 
To create an acoustic distance effect Spatial Audio Workstation can apply automatic 

volume and EQ processing depending on the object’s position from the center. The 

Decay radius value determines the onset of this processing and can be displayed on 

the Stage view by selecting the appropriate View setting. For an object positioned 

within the Decay radius no volume or EQ processing is applied.  

For any position outside this radius the object’s distance parameters determine the 

attenuation of volume and high frequencies. 

 

Set as default 

 

By clicking “Set as default” the chosen project settings can be set as a default for newly 

created Spatial Audio Workstation projects. 
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1.5.2 Preferences  

 

Go to Spatial Audio Workstation’s Settings menu and select Preferences to open the 

Preferences window. There are several tabs containing a number of global settings for the 

plug-in. These settings will be retained after Nuendo is closed. 

 

General  

 

In the General tab you can define the unit of measurement that is used in the Stage view 

and parameter input fields.  

 

▪ GUI unit  

Spatial Audio Workstation’s coordinate system can be displayed in meters or feet. 

Changing the unit does not affect the operation of the Spatial Audio Workstation or 

projects that were created using another unit of measurement. It only alters how 

space is measured in the GUI.  

  

Stage View  

 

The Stage view tab allows you to customize the appearance of the GUI.  

 

 

Figure 3: The preferences Stage View tab 

 

▪ Colors   
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Clicking on any of the color swatches will bring up a color selector tool that you can 

use to customize the way things look in the Spatial Audio Workstation.  

▪ Horizontal step size  

The value here determines what the distance is between each horizontal line of the 

grid.  

▪ Vertical step size  

The value here determines what the distance is between each vertical line of the 

grid.  

▪ Show axes  

The axes (X, Y) define the position of the listener on the Stage. When the axes are 

visible, you can reference the listening position easily.  

▪ Axes style  

This pull-down menu has six choices for how the axes lines are drawn: dot line, dash 

line etc.  

 

Shortcuts  

 

The Shortcuts tab contains a list of key commands for faster operation of Spatial Audio 

Workstation. These key commands only work when Spatial Audio Workstation is the 

active window in Nuendo. Otherwise, key commands will be directed to and 

interpreted by the Nuendo main program.  

 

External processing  

 

When using external processing the object-based scene created with Spatial Audio 

Workstation must be transmitted in real-time to an IOSONO processing hardware. 

Object metadata is transmitted via network. Set the Scene IP address to the IOSONO 

processor’s IP address and the Scene port to the default 4243 if not configured 

otherwise on the processor. The related audio data for all objects is routed to output 

channels of the soundcard device configured in Nuendo’s menu Devices – Device Setup 

– VST Audio System. Most likely this is a multichannel soundcard with 64 channels via 

MADI. 

In the External processing tab select all outputs from the Available output ports list 

that you want to connect to the external processing hardware and add these to the 

Selected output ports list. The number of output ports determines the number of 

sound objects playing simultaneously within a scene. The ordering and allocation of 

output ports is done automatically by Spatial Audio Workstation. 
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Export  

 

Set a Temporary files path that is needed during export of Spatial Audio Workstation 

projects. 

 

1.5.3 Nuendo VST output configuration  

 

The Spatial Audio Workstation automatically creates its own VST Output bus. This bus is 

named „SAW Internal Mix” when the projects runs in internal processing mode or “SAW 

External Mix“ when external processing is selected. 

The “SAW Internal Mix” bus will match the configuration for the Active bus arrangement 

chosen in Spatial Audio Workstation’s Project settings. The individual channels of the created 

output bus must be routed to the audio device configured in Nuendo’s VST Audio System. Go 

to Nuendo’s Devices menu and select VST Connections (F4) to access the routing options. If 

the “SAW Internal Mix” bus is set as the Main Mix in VST Connections, you may use Nuendo’s 

control room feature to route the signals to your loudspeaker system. When completed, your 

VST Connections - Outputs should look something like the figure below.  

Once the VST Outputs have been configured, you are ready to start creating a scene by placing 

sound objects within Spatial Audio Workstation’s Stage view.  

 

 

Figure 4: VST Connections - Outputs configured for use with the Spatial Audio Workstation 
(internal processing to 5.1) 

 

1.5.4 Overview of the Spatial Audio Workstation window  
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The Spatial Audio Workstation window is accessible from Nuendo’s Project menu. It takes a 

lot of screen real estate and should be displayed on a dedicated screen for best ergonomics. 

When starting a new Nuendo project and first open the Spatial Audio Workstation window, it 

will not contain any sound objects and be fairly blank except for the “Activate” button. This is 

due to compatibility reasons for exchanging projects with Nuendo users who do not have the 

Spatial Audio Workstation plugin on their system. The figure below shows the Spatial Audio 

Workstation window populated with several different sound object types to illustrate the 

components of the user interface.  

 

 
 

 

Figure 5: The Spatial Audio Workstation window 

 

1. Stage view  

This area of the plug-in window represents a top view of the sound field. A dimensional grid 

details the physical position of sound objects in user-determined increments (meters or 

feet). The loudspeaker setup is represented by small icons showing their positions within 

the sound field. 

2. Spatial Audio Workstation sound objects  
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There are several types of sound objects in Spatial Audio Workstation. Each one can be 

manipulated and positioned independently of the others.  

3. Spatial Audio Workstation toolbar 

The tools collected in the toolbar provide access to automation modes, various selection 

modes, allow you to edit aspects of motion paths and give you zoom controls for the Stage 

view. 

  

4. Object parameters  

The lower section of the window contains all parameters of the currently selected sound 

object.  

Each parameter can be automated over time just like with any other plug-in type in Nuendo. 

This is how you can create dynamic motion of sound in Spatial Audio Workstation.  

5. Speaker Icons  

When using Internal processing mode the speaker’s icons match the positions of the chosen 

Active bus arrangement. When using External processing mode with a custom venue the 

loudspeaker positions can be read from a loudspeaker setup file.  

6. Objects list  

Each sound object created in a project whether it is a Channel, Event, Zone or Group objects 

will be listed here.  

7. Layers list 

Spatial Audio Workstation projects may get very complex. Layers are used to organize the 

numerous sound objects visible on the Stage view in manageable collections (layers) of 

related objects. 

8. Motion path  

A Motion path represents the route of an object visible on the Stage view as it moves within 

the sound field.  

 

 

Spatial Audio Workstation data  

The data that is created by using the Spatial Audio Workstation plug-in is saved inside the 

Nuendo project file (.npr). This happens automatically when the Nuendo project is saved. No 

additional action is required to preserve this data. It is recommended that you always backup 

your project data. Copying the Nuendo project folder to a secure location or using Nuendo’s 

backup function from the File menu will protect your project data.  
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Note: Be aware of any Nuendo project that contains Spatial Audio Workstation data should 

not be edited or opened while the program plug-in is not active or installed. This may cause 

unpredictable behavior and possible corruption of the data.  

 

 

Markers and Guides  

Multiple markers and horizontal or vertical guides can be used on the Stage view to aid in 

positioning and moving sound objects. Each marker and guide can be set to an individual color. 

Markers can also be named. Markers and guides may be created from Spatial Audio 

Workstation’s View menu or by right-clicking on an empty area of the Stage view.  

▪ When you select “New marker“, the dialog will allow you to enter a name and 

description and choose a color for the marker. The marker will appear at the position 

where you last clicked in the Stage view.  

▪ By selecting “New guide“, the dialog offers choices of horizontal, vertical, X or Y 

position, line style and color.  

Once they are created markers and guides may be moved to a different position in the Stage 

view simply by click and drag. When markers and guides have their final positions, they can 

be locked in place, to prevent from further editing. This is done in the View menu or the Stage 

view’s context menu. 

 

 

Figure 6: Two markers and two guides 

 

2. Spatial Audio Workstation objects 

2.1 Introduction 

 
In the Spatial Audio Workstation the term object belongs to the representation of a sound 
source in the surrounding 3D sound field. The most obvious property of an object is the 
position in x, y and z coordinates. But an object can hold even more parameters to characterize 
a sound depending on the selected object type. 
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There are three basic types of Objects: Channel Objects, Zone Objects and Event Objects. 
Channel Objects are sources of audio that may contain one or more sounds mixed together, 
but coming from one location in the 3D sound field. You may think of this as a virtual 
loudspeaker that may be moved around the listening area. Zone Objects also represent one 
sound but instead of a free position on stage these objects assign this sound to a defined 
speaker zone output (i.e. Left Wall). Event Objects are singular sounds that have a duration 
with specific start and end times. An Event Object only exists for that given period of time and 
can also be moved around the 3D sound field.  
All Object types can coexist in the same Nuendo project.  
 
Group Objects contain one or more Event Objects that are linked together allowing them to be 
manipulated together as a single entity. Group Objects do not have any audio signals 
themselves but are used to control the positions of the Event Object members of the group. 
 

 

Figure 7: Point Source, Plane Wave, Upmix, Zone and Group Object icons 

 

2.2 Creating objects 

 
In order to create an Object in the Spatial Audio Workstation, you must first create an audio 
track or a group channel track in Nuendo. The Spatial Audio Workstation is capable of dealing 
with mono or stereo tracks. Mono tracks are represented as Channel, Event or Zone Objects 
with Point Source, Plane Wave or Zone Object icons. Whereas stereo tracks automatically 
result in Channel or Event Objects with an Upmix Object icon. Stereo tracks cannot be 
represented as Zone Objects. 
After you created the track you must route its output to the SAW Internal/External Mix bus. 
Then right-click on the pan control in the mixer channel (or Track Inspector) and select 
“Spatial Audio Workstation“. As soon as you do this, you will see a new Channel Object appear 
in the Stage view.  
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Figure 8: Selecting the SAW panner in the Mixer by right-clicking in the panner area 

 

 
Note: All objects are mono or stereo audio sources. Therefore only audio tracks or group 
channel tracks in mono or stereo configuration can be used to create objects in the Spatial 
Audio Workstation.  

 
Audio Track Mode: Channel, Zone or Event  
Newly created audio tracks that are assigned to the SAW Internal/External Mix bus and use 
the SAW panner will show up in Channel mode by default. In Channel mode, each track creates 
a single Channel Object. Only audio tracks are capable of being switched into Event mode, 
whereby each audio event in the track creates a separate Event Object in the Spatial Audio 
Workstation. A single audio track may contain many Event Objects. Event Objects are further 
explained in “Event Objects”, chapter 2.2.3.  
 
In order to change the track mode of an object from within the Spatial Audio Workstation, click 
on the corresponding button in the object parameter editor. The track mode can also be 
switched in Nuendo, by selecting one or more audio tracks and from the Project menu 
choosing „Spatial Audio Workstation -> Switch selected tracks to … mode“. Now all selected 
tracks will be in the chosen mode. If any audio events are present on those tracks, Event 
Objects (one for each audio event) will appear in the stage view at their starting positions and 
in the Object List. For more on the three Audio Track modes, see Audio Track modes, chapter 
3.4.3.  
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Note: Only audio tracks can be switched to Event mode. Group channel tracks in Nuendo 
don’t have audio events and therefore can create only Channel or Zone Objects. The event 
mode switching option in the Project menu will appear grayed out for selected group channel 
tracks. 

2.2.1 Channel Objects 

 
Channel Objects are like virtual speakers that can move anywhere within the 3D sound field. 
The sound that is coming through that audio or group channel track will be positioned where 
the Channel Object is located in the Stage view. Using group channel tracks to create Channel 
Objects, multiple audio sources can be routed to that group channel and the resulting mix will 
be presented at the location of the Channel Object in the 3D sound field. 

2.2.2 Zone Objects  

 
Zone Objects have all properties of Channel Objects but, instead of being moved around these 
objects have a fixed output speaker assigned. The assignment is done in object editor by using 
the “Zone ID” drop-down menu. To ensure correct playback, the Zone IDs of all Zone Objects 
in use must be assigned to at least one output speaker in the loudspeaker file. For mixing 
projects using one of the legacy surround setups (Internal processing mode) or the norm stage 
(External processing mode) all the pre-defined Zone IDs are already assigned. When working 
with a custom venue (External processing mode), please refer to the manual of the Barco 
AudioCue processor on how to assign Zone IDs to the different loudspeakers.  
 

2.2.3 Event Objects  

 
Event Objects are more specialized than Channel Objects since they have specific time 
duration in addition to their spatial position. In order to create Event Objects you must have 
an audio track routed to the SAW Internal/External Mix bus with the panner set to “Spatial 
Audio Workstation” and the track switched to Event mode. Once an audio track is in Event 
mode, any audio event placed or recorded in that track will create a corresponding Event 
Object in the Spatial Audio Workstation. Follow these steps to create multiple Event Objects 
on a single audio track in Nuendo: 
 

1. Create a mono or stereo audio track in Nuendo and route the output to the SAW 
Internal/External Mix bus.  

2. Insert the Spatial Audio Workstation panner by right-clicking on the pan control in the 
mixer. This will first create a Channel Object.  

3. Switch the track from Channel mode to Event mode using the Project menu in Nuendo 
or the buttons in the object editor. 
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Figure 9: A single event object 

 
4. Either record a portion of audio or place an audio file from the Pool onto the audio track 

and an Event Object will be created in the Spatial Audio Workstation.  
You will see the Event Object icon in the Stage view and associated items in the Objects 
and Layers lists to the right.  

5. Placing additional audio events on the same track will create more Event Objects.   
A new Event Object is created by each audio event on the track. Event Objects are only 
active when the cursor is between the start and end boundaries of that audio event. 
Otherwise the object icon will be greyed out. 
 

 

Figure 10: A second Event Object is created on the audio track 
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Initially, each object for a mono track is displayed with a Point Source icon placed at the 
listening position in the center of the stage view. Whereas Upmix Objects for stereo tracks  
appear at the position of the center speaker. All Event Objects are independent from each other 
and can be moved anywhere in the stage view. 

2.2.4 Upmix Objects 

Upmix Objects are created for audio or group tracks in stereo configuration. They are not 
working like virtual speakers, but they represent a sound field surrounding the listener. Upmix 
Objects transform a stereo input signal to the surround speaker configuration used in the 
project. Just like objects created from mono tracks, the Upmix Objects can also be used in 
Channel or Event mode, but not in Zone mode. For more details about Upmix Objects and their 
parameters see “Upmix Object Parameters”, Chapter 2.5.3. 

2.2.5 Group Objects 

Once you have created more than one Event Object, you may join them together and form a 
Group Object. Group Objects allow you to control the positioning and motion of more than one 
Event Object relative to the center of this group. Group Objects can be moved around the Stage 
view, causing all of the Event Object members to move relative to the Group Object icon. 
 
Creating a Group Object:  
 

1. Select two or more Event Objects in the Stage view or Objects list.  
Only Event Objects and other Group Objects can be grouped together. It is not possible to 
group Channel or Zone Objects. 

2. Placing the mouse over one of the selected objects in the stage, right-click and choose 
“Group selected” from the context menu.                 
You may also choose the same option from the Edit menu of the Spatial Audio Workstation 
or use the shortcut Alt+G.  
 

 

Figure 11: Creating a Group Object 

 
3. You will see a newly created Group Object appear at the center of the Stage view.  
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This Group Object now controls the relative positions of the two Event Objects. 
 

 

Figure 12: A Group Object with two members 

When a Group Object is created the Spatial Audio Workstation adds an IOSONO Group track 
to Nuendo’s track list. This track looks like an audio track, but it holds no audio only 
automation data written by the Spatial Audio Workstation when moving a Group Object. 
 

2.3 Objects list  

 
The Objects list in the Spatial Audio Workstation displays all of the objects in the currently 
active Nuendo project along with controls for the status of each object. 
 

 

Figure 13: The object list 

 
 
The first column in the Objects list displays the icon and name for each object. You may double-
click on the name to change it. In case of an Event Object, changing its name will also change 
the description field for the corresponding audio event in Nuendo’s event display. To the right, 
there are check boxes to enable or disable the status of each object as follows:  
 

▪ Solo  
▪ Mute  
▪ Automation Read  
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▪ Automation Write  
▪ Lock  
▪ Visibility  

 
Object visibility  
In the Objects list the visibility status for each object can be set. There are three states of object 
visibility:  
 

▪ Visible  
When the check is light grey, the object will be shown on the Stage (assuming its parent 
Group object and layer are visible as well).  

▪ Invisible  
When the box is un-checked, the object will not be seen on the Stage (except for currently 
selected objects, which are always visible) 

▪ Auto-visible (for Event Objects only)  
When the check is dark grey, Event Objects will only be visible when active (the play cursor 
is within their start and end times). 

▪ Members of Group objects will follow the visibility of the Group object unless they are 
already not visible. 

▪ Visibility is also affected by the status of the layers. If a parent layer is not visible, child 
objects will not be visible as well. For more information on layers, please refer to 
“Spatial Audio Workstation Automation”, chapter 3. 

 

2.4 Layers list 

 
In Spatial Audio Workstation layers are used to organize multiple objects into sensible groups. 
By default, a “Base layer” is created when you start a new Spatial Audio Workstation project. 
All objects created in this project will be assigned to this default “Base layer”. New layers may 
be added as needed. In contrast to Group Objects a layer of objects has no visual representation 
in the Stage view. 
 
To create a new and empty layer, choose “Add layer” from the Spatial Audio Workstation’s Edit 
menu. You can also right-click in an empty region within the Layers list and choose “Add 
Layer”. Drag various objects into the layer as needed. Each layer can be renamed by double-
clicking on its name in the Layers list. The arrow next to it is used to open and close the layer 
(as well as groups) to reveal or hide its member objects.  
 
 
 
 
It is also possible to create a new layer by selecting one or more objects from the Layers or 
Objects list and choose “Move to new layer” from either the Edit menu or right-click context 
menu. This will move all selected objects to a new layer. Objects may be moved between layers 
to reorganize them. Simply drag the object from one layer to another. 
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Figure 14: The layers tab 

 
Each layer has check boxes for locking and visibility control in the Layers list. Locking a layer 
will cause all objects in that layer to become locked. This provides a convenient way to deal 
with projects that contain a large number of objects as the Stage view can easily become 
crowded when many objects are visible at the same time.  
 

2.5 Object parameters  

 
Each object in the Spatial Audio Workstation has a set of parameters that will be outlined in 
this section. Certain parameters are only associated with Event, Channel or Zone Objects while 
others are associated with only Group Objects. Each of these object parameters can be used in 
automation mode. 
 

 

Figure 15: Object parameters for an Event Object 

 
▪ Track mode  

Change the object type of the associated audio or group channel track with the three 
buttons in the upper left hand corner.  

▪ Object name  
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Below the Track mode buttons is a text field with the name of the selected object. You can 
edit the name in this field.  

▪ Solo/Mute/Read/Write/Lock/Visibility       
Allows you to set the status of currently selected object(s)  

▪ Volume  
Adjust the playback volume of an object in the Spatial Audio Workstation. This control is 
independent from other volume adjustment made in Nuendo (like track volume or audio 
event volume). The object volume can be automated in real-time. The processing is done 
on the rendering side. 

▪ LFE  
Similar to traditional LFE controls, this slider adjusts the signal level fed into the subwoofer 
system.  

▪ Spread (for Channel and Event Objects only)  
This parameter determines how much of the signal is directed to all speaker channels in 
the neighboring area of the object position. At 100%, the signal will be equally distributed 
to all speaker channels. At 0%, the signal is directed only to the position of the object in the 
stage. This parameter is not available for Group objects.  

▪ Delay  
This object delay is used to delay the associated audio signal either manually or 
automatically according to the distance of the object from the central listening position. If 
‘Auto’ is enabled, the Spatial Audio Workstation will determine the natural amount of delay 
according to the law of speed of sound for the distance between the object and the central 
listening position. As the object moves around the 3D sound field, this delay amount will 
change accordingly. The automatic delay is available for both, objects representing mono 
audio tracks and also Upmix Objects. In addition to the automatic or distance dependent 
delay, it is also possible to set the amount of delay manually. Since Group objects may have 
more than one member, only a manual delay setting is available for each Group. The 
processing of the delay is done on the rendering side. 

▪ Automatic Decay  
By switching from the Delay settings tab to the Distance tab you can activate an automatic 
distance dependent volume and equalizer adjustment. See 2.5.2 for more details on these 
settings. 

▪ Cartesian Coordinates (X/Y)  
Using grid values, an object can be positioned using X and Y coordinates for very precise 
setting of its location in the 3D sound field.  

▪ Polar Position  
By switching from the Cartesian tab to the Polar tab, angle and distance values can be used 
to set the object position. 

▪ Height Position  
The object’s height parameter depends on the protocol used for sending the scene data to 
the rendering unit (See project settings paragraph 1.5.1) In Vertical Pan mode you will see 
a ‘Height’ slider next to X and Y ranging from -100% to +100%. Below the X and Y value 
boxes is a display of the resulting VPan layer ID. In Generic 3D mode the height is 
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represented by a Z value slider and box in meters or feet. By switching from the Cartesian 
tab to the Polar tab, you will see an Elevation value box to enter the height position. 
 

2.5.1 Object position  

 
Objects can be positioned intuitively using the Stage view’s GUI. Simply click and drag the 
object icons in the Stage view to change their position. You can position objects anywhere on 
the stage within the limits of +/-50m. This includes positioning directly on the loudspeaker 
array, but also inside or outside of the loudspeaker array. The X and Y coordinates will update 
accordingly to reflect the position of objects in the Stage view. For practical guidance you can 
overlay the Stage view with a representation of the loudspeaker setup, markers, guidelines or 
even a picture map of a given venue. 
 
Cartesian coordinates  
Objects may be positioned using X and Y coordinate values. The X and Y axes are defined by 
the listening position. In order to see these axes, choose Settings-->Preferences-->Stage View 
and check ”Show axes“. Depending on what unit of measurement the grid has been set to in 
Preferences, simply enter a value in meters or feet into the Cartesian coordinate fields to 
accurately place an object anywhere in the 3D sound field. 
 
Polar coordinates  
Objects can also be positioned using the angle and radius parameters found in the Polar tab. 
Angle determines the degree at which an object is placed relative to the center point of the 
Stage view. A value of 0 degrees means the object is located straight in front of the central 
listening position. The radius is the distance between the object and the central listening 
position. As the angle and radius parameters are adjusted, notice that the X and Y coordinates 
also change to reflect the new position. 
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Figure 16: Polar positioning tab parameters 

 
Height / Elevation 
The availability of the Height slider (shown in the Cartesian tab) respectively the Elevation 
dial (shown in the Polar tab) depends on the selected processing mode and output 
configuration chosen in Spatial Audio Workstation’s Project settings.  
 

▪ For projects running in Internal processing mode the Height slider is shown in its 
default range from -100% to +100%, but only available for pre-production purposes 
(i.e. in preparation for finalizing the mix in a facility that is equipped with an IOSONO 
processor). Since all legacy loudspeaker setups, that are currently available in Internal 
processing mode, do not have elevated loudspeakers, changing the height value of an 
object has no audible effect in this processing mode. 

▪ For projects running in External processing mode and using the “Vertical Pan” scene 
protocol the Height slider has also a default range from -100% to +100%. Working with 
the ‘norm scene’ this means the lowest value of -100% equals Layer ID -1, the value 0% 
equals Layer ID 0 and the upmost value of +100% results in Layer ID +2. To change this 
default range a custom venue loudspeaker file must be loaded in the Project settings. 
In this case the resulting range of the Height slider will be set to the number of vertical 
loudspeaker layers (-n .. 0 .. +m) configured in this file. The Elevation dial is not 
available for projects using “Vertical Pan”. 

▪ When running in External processing mode and the scene protocol is set to “Generic 
3D” the values of the Height slider represent units of length instead of layer IDs. The 
Elevation dial offers a range from -90° (downmost) to +90° (upmost). A value of 0° 
means an objects position on the height = 0m plane. 
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2.5.2 Auto decay 

 
The parameters of this section provide control of volume decay and high frequency roll-off for 
each object according to its position in the 3D sound field. Objects moving away from the 
central listening position will be lowered in volume and damped in high frequencies to 
simulate the physics of sound radiation in free space including air damping effects. The 
settings are available for objects representing mono audio tracks as well as Upmix Objects. 
 
 
Distance Dependent Volume 
For each object you can set an automatic volume reduction by adjusting the decay factor 
between 0x and 4x. If the value is set to 0x (default), the distance dependent volume feature is 
effectively turned off. A decay value of 1x equals a natural sound volume drop of -6dB per 
doubling of distance. A higher decay setting will lead to a faster volume reduction of the 
object’s audio signal. 
When active, the distance dependent volume will behave like an offset to the “Volume” and 
“LFE” values for the object. Therefore the Total Volume and Total LFE of the selected object 
are displayed in the top left corner of the Distance tab. It takes into account both the Volume 
and LFE sliders combined with the calculated distance dependent volume, is then. 
 
Distance Dependent EQ 
You can use the distance dependent EQ in addition to the volume reduction to mimic air 
absorption effects for objects moving farer away. This is done by using a distance controlled 
high shelf filter. Similar to the distance dependent volume, the EQ gain will be adjusted with 
the decay value set by the user. A value of 0x will turn off the function. A value of 1x equals a 
gain of -6dB per doubling of the object’s distance. For fine adjustments the cut-off frequency 
of the filter can be set from 250Hz to 20kHz. 
 

 

Figure 17: Automatic decay parameters 
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In the Project settings you can define the onset of the distance dependent processing by the 
Decay radius value. For an object positioned within the Decay radius no volume or EQ 
processing is applied. For any position outside this radius the object’s distance parameters 
determine the attenuation of volume and high frequencies. The decay radius can be displayed 
on the Stage view by selecting the appropriate View setting. 

2.5.3 Upmix Object parameters 

 
Upmix Objects can be used to create surround signals out of regular stereo tracks. The 
different parameters of the upmix algorithm allow for different characteristics of the upmix, 
e.g. width of the sound image, separation and control of direct and ambient signal components, 
rotation of the resulting surround signal, etc. 
 
You can control the different upmix parameters when an Upmix Object is selected.  
To have a visual feedback of the current parameters, an upmix overlay can be displayed in the 
Stage view. To activate the upmix overlay, click on the “Upmix stage overlay” button. You can 
also activate the stage overlay by double-clicking the Upmix Object in the stage view. To hide 
the upmix overlay again, use the “Upmix stage overlay” button or click outside the stage 
overlay in the stage view. 
 

 

Figure 18: Tool buttons with activated upmix stage overlay 

 
The upmix algorithm extracts ambience signal components out of the stereo signal and allows 
manipulating direct and ambience signals separately. The direct signals are arranged as a 
configurable stage while the ambience signals are placed around the listener. 
 
The different parameters of the upmix can be adjusted using the object parameter controls at 
the bottom of the Spatial Audio Workstation window. 
 
 
Upmix parameters for Direct Signal Components 
 

▪ Dry/Wet 
Control the amount of ambience signal in the stage that is defined by the stage width. Dry 
corresponds to a more direct signal from the stage, whereas wet corresponds to more 
ambient signal from that direction. 

▪ Stage Width 
Control the perceived width of the resulting stage image in degrees. A maximum stage 
width of 180° is possible. Up to 90°, the width of the direct components in the stereo signal 
is adjusted, while values above 90° result in additional broadening of the direct signal 
components. 

▪ Rotation 

http://www.barco.com/
http://www.iosono-sound.com/


Spatial Audio Workstation User Manual 
 

 

Page 28   

 

www.barco.com I www.iosono-sound.com  
 
 
 
 

The resulting surround signal of the upmix processing can be rotated around the central 
listening position. All signal components, including direct and ambient signals, will be 
rotated by the same amount. The rotation can also be adjusted by changing the position of 
the upmix icon in the stage view. 

▪ Divergence 
This parameter controls the processing of a center signal in the stage out of the stereo input 
signal. A lower value produces a stronger dedicated center signal. A higher value spreads 
the center signal evenly throughout the stage.  

 
Upmix parameters for Ambient Signal Components 
 

▪ Gain 
Control the level of the ambience signal within the surrounding upmix in dB. 

▪ Front/Rear 
Control the front-rear balance of the surround ambience. In order to have more ambiences 
in the back than in the front, pull down this slider.  
Note that the front-rear balance will be applied before the rotation, so “front” always 
corresponds to the direction of the stage. 

▪ Delay 
This parameter adds a delay to the ambience signal components in relation to the direct 
signal extracted from the stereo input.  

▪ Low Pass 
Control the frequency in Hz of a low pass filter which is only applied to the ambience. The 
direct signal is not affected by this parameter. 
 

 

 

Figure 19: Visualization of different Upmix parameters in the stage overlay 

 
Global Parameters 
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▪ Upmix/Original 

The “Original” signal corresponds to a regular stereo panning of the Upmix Object’s input 
signal, controlled just by the parameters “Stage Width” and “Rotation”. No additional 
upmix processing is performed on the “Original” stereo sound. Use the Upmix/Original 
slider to set the balance between the original stereo signal and the upmix signal. 

▪ Bypass 
This button can be used to compare the upmixed result with the unprocessed stereo signal. 
If bypass is active, the input stereo signals are placed in the front at -30° and +30° without 
any signal processing or rotation applied. 

 

 

Figure 20: The controls for all upmix parameters 

 
Parameter Sets 
 
There are four predefined sets of upmix parameters that can be applied to the currently 
selected Upmix Object (Default, Pointed, Moist, Open). These four sets correspond to different 
upmix characteristics that can be applied quickly and build a starting point for further 
parameter adjustments. Choose the parameter set you want to start with in the “Set 
parameters” drop-down menu. 
 
To store and restore a user defined upmix parameter set, the entries “Store user“ and “Recall 
user” can be selected. The user set is global for all projects but will only be available until 
Nuendo is closed. It can also be used to copy parameters to other Upmix Objects or projects. 
 
Note that a locked parameter will not be overwritten when a parameter set is applied. 

2.5.4 Group Object Parameters  
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Group Objects have a slightly different set of parameters than Channel or Event Objects. While 
basic positioning is handled in the same way, Group Objects have additional rotation and scale 
settings to address relative positioning of the group’s member objects.          
 
Group Objects do not have Spread and Auto-Delay settings.  
 
Rotation  
The Rotation parameter of a Group Object alters the relative positions of all member objects 
around the Group Object’s center (indicated by the Group Object icon). This should not be 
confused with the Group Object’s Angle parameter, which controls the position of the Group 
Object around the central listening point on the stage. The figure below shows how the 
rotation of a Group Object affects its member objects. The group icon also reflects the rotation 
of the group by the position of the notch.  
 

 

Figure 21: Group rotation with notch indicator 

 
X and Y Scale  
The X and Y Scale parameters affect the relative position of group member objects in both axes. 
By adjusting the X Scale parameter, member objects will spread out or constrain together 
proportionally on the horizontal axis of the stage. The same is true for the Y axis scale 
parameter. This is expressed as a ratio.  
Values less than 1 reduce the distance between member objects while values greater than 1 
(up to 100) increase the distance between objects in this group.  
 
By pressing the “Join” button, the X and Y Scale parameters are linked for circularly 
proportional scaling of group members.  
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Figure 22: When checked, the “Join” button links the X and Y Scale parameters together for 
proportional scaling 
 
For more information on these Group Object parameters, please see “Group Object 
Automation”, chapter 3.4.2. 
 

2.6 IOSONO special parameters 

 
The following object parameters are effective only when using the Spatial Audio Workstation 
with an IOSONO processing system (e.g. the Barco AudioCue Spatial Audio Processor).  
However, you can access these parameters also in internal processing mode, in preparation of 
an IOSONO mix in a studio environment using a legacy multichannel speaker system and 
transfer this project to an IOSONO system later. 
 

 

Figure 23: IOSONO special parameters 

 
On screen  
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The “on screen” switch is used to always keep the position of an object that is visible on the 
screen consistent with the corresponding audio object.  
On playback, the Spatial Audio Processor considers the real dimension and position of the 
existent screen and corrects the position of the Object accordingly. 
 
Source Type 
Each Event or Channel Object representing a mono audio track can radiate sound in two ways: 
 

▪ Point Source: an audio source with a constant position in space  
Point Sources radiate spherically from a single point in space. For example, a car driving 
into a driveway is a Point Source. As the car moves across the driveway, the listener 
perceives changes in the sound. A listener in a different location on the driveway will hear 
the Point Source in a slightly different way. The same is true for processing Point Sources 
in an IOSONO system. Point Sources are useful when each listener should perceive a 
localizable sound source. Two listeners in different parts of the listening area surrounded 
by the loudspeakers will be presented with a different sonic image of the Point Source, but 
both of them are able to locate the sound from the same point in space. 

▪ Plane Wave: an audio source with a constant direction relative to each listener in the 
audience area 
Plane Waves appear to all listeners as if they origin from the same horizontal direction. You 
could consider a Plane Wave to be a Point Source that is an infinite distance away from the 
listener. Plane Waves are useful when each listener should perceive the same directional 
sonic image produced by that sound. Ambient sounds are particularly effective as Plane 
Waves. 

 
Each object can be either a Point Source or a Plane Wave. Objects can change its characteristic 
from Point Source to Plane Wave and back again using the automation features of the Spatial 
Audio Workstation. 
 
Dialog / Aux1 / Aux2 
These flags can be used to address special rendering features in an IOSONO audio processor. 
One example is a separation of a scene into individual parts. Objects flagged with Aux1 can be 
exclusively rendered to a certain subset of loudspeakers in a setup with multiple loudspeaker 
groups. Objects without that flag (Aux1=OFF) will be excluded from that loudspeakers and 
rendered only to the main loudspeaker setup. 

3. Spatial Audio Workstation automation  

3.1 Introduction  

 
Using the Spatial Audio Workstation to place individual sound objects at static positions in a 
3D sound field can be immersive and captivating. The ability to move these objects around in 
real-time takes it to a whole new level. Every parameter of an object can be automated in real-
time using the powerful automation system. Objects in the Spatial Audio Workstation can be 
write- and read-enabled just like channels in the Nuendo mixer.  
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To write-enable an object, check the write box next to its name in the Objects / Layers list or 
use the shortcut Alt+W for all selected objects. By default, Read is also enabled when you put 
an object in Write mode. You can toggle the read status of an object using the check box or 
shortcut Alt+R.  
 
When a sound object is write-enabled, the red W icon appears next to the object’s icon in the 
Stage view along with the green R (read-enabled) by default. Also, the “Read” and “Write” 
buttons next to each object parameter light up in green and red. Individual parameters may 
be read or write enabled or disabled individually by clicking on the buttons next to each 
parameter. You may also lock individual parameters to maintain previous automation runs by 
clicking on the padlock icon for that parameter.  
 

 

Figure 24: A Channel Object in write mode 

 
Note: The write and read status of objects in the Spatial Audio Workstation are not 
reflected in Nuendo. Automation using the Spatial Audio Workstation GUI does not need 
the Nuendo track to be write-enabled. In order to write automation for object parameters, 
the object must be put in write mode from within the Spatial Audio Workstation GUI 
window.  
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3.2 Creating motion paths  

 
Automation in the Spatial Audio Workstation is somewhat different compared to other Stereo 
or Surround panning plug-ins. This is due to the fact that positioning objects is regardless of 
the amount of speaker channels present in the monitoring system. It’s not simply the relative 
level of audio signal in various speaker channels that is being automated. The Spatial Audio 
Workstation actually renders the position of the audio signal to the current speaker 
configuration as set in “Project Settings”, chapter 1.5.1.  
 
The basic component of Spatial Audio Workstation automation is called a motion path. A 
motion path is the pathway that an object follows as it moves throughout the 3D sound field.  
Motion paths can be simple straight lines from A to B or complex curves that meander around 
in space. Once created, Motion paths appear as yellow lines on the Stage view. There are four 
ways to create motion paths in the Spatial Audio Workstation:  
 

▪ Real-time automation to draw complex curved paths  
▪ Move automation to create simple straight paths  
▪ Jump automation to create instant movements  
▪ Drawing in X, Y and Z values directly in Nuendo’s automation lanes  

 
 

 

Figure 25: A motion path in the stage 

 

3.2.1 Real-time automation  

 
Real-time automation is the most intuitive way to position a sound object over time. Just write-
enable the object in the Objects List, hit play and move the object icon around in the Stage view 
as you desire. When you enable write mode in the Spatial Audio Workstation, automation read 
is also enabled for that object. Upon playing back, the object will follow the exact motion you 
performed. Besides the position any other object parameter can be automated in this manner.  
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3.2.2 The Spatial Audio Workstation automation modes 

Automation modes can be switched in the toolbar of the Spatial Audio Workstation window. 
 

▪ Touch  
When operating in Touch mode, automation data is written when touching a parameter 
control or an object in the Stage view.  On release the control returns to the previously set 
value. 

▪ Auto Latch 
In Auto Latch mode writing of automation data starts on touching a parameter control or 
an object in the Stage view and continuous until playback is stopped. 

▪ Prime Latch  
This mode is basically similar to Auto Latch except that the Prime Latch enabled 
parameter(s) start writing automation data instantly on playback start. 
You can set a control to Prime Latch mode by toggling the “P” button next to it. 

▪ To End  
When Automation “To End” is set, the object’s last position is preserved, either until the 
end of the Nuendo project for Channel and Group Objects or to the end time of the audio 
event for Event Objects. Of course, that automation can be amended with more 
automation data. But for a single pass the object will stay at the final position in the motion 
path until the end time for that object. Be aware of the potential risk to overwrite previous 
automation data. 
Nuendo projects using the Spatial Audio Workstation have an end time of 24 hours.  
 

 

Figure 26: The SAW automation modes and the “to End” button in the toolbar 

 

3.2.3 Move and jump (keyframe mode)  

 
The second method of creating motion paths and automation involves a step by step process 
whereby you create simple, straight motion paths and either have the object move gradually 
(move) or instantly (jump) from the start to the end of the path.  
 
Create Move Automation  
Move automation allows you to have an object move smoothly from one point to another in a 
straight line over time. To create a simple straight motion path using Move automation, follow 
these steps:  
 

1. Create an Event or Channel Object  
While Move automation works with Group Objects, it is best to start with single objects for 
simplicity.  
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2. Place the object at the desired start position on the Stage view.  
Using the object selection tool, drag the object to the start position.  

3. Enter Keyframe Mode  
Press the “Initialize Key frame Mode” button in the. This creates a starting keyframe at the 
current time and position for the selected object.  

4. Move the Nuendo playback cursor forward in time.  
Move to the time when you would like the object to reach to its destination.  

5. Move the object to a new destination on the Stage view.  
6. With the object selected, press the “Keyframe Move” button in the toolbar.  

This defines the end of the motion path with another control point and keyframe.  
7. You will now see a yellow motion path that goes from the start to the end positions 

similar to the figure below.  
When you play back, the object moves smoothly from the start of the motion path to the 
end during the specified time.  
 

You can continue to create Move automation later in the timeline by repeating steps 4 through 
7, creating new motion path segments. 
 

 

Figure 27: Keyframe Tools 

 
Creating Jump Automation  
Jump automation works in much the same way as Move automation. The only difference is 
that the object will jump instantly from one point to another instead of gradually. In order to 
create Jump automation, follow the same steps outlined for Move automation but replace the 
“Keyframe Move” button with the “Keyframe Jump” button. By following steps 4 through 6 
repeatedly, you can create successive Jumps, each one having its own motion path segment.  
    
Moves and Jumps can be mixed together in one motion path. 
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Figure 28: Two motion path segments created with Move automation 

 
 

3.2.4 Nuendo automation lanes  

 
The last method of creating and altering motion paths is by direct editing of the automation 
lanes in Nuendo. The position and motion of any object is represented in Nuendo by X and Y 
coordinates. Each axis has its own automation lane. By drawing in automation points in these 
lanes, motion paths will be changed in the Spatial Audio Workstation.  
 

3.3 Anatomy of a motion path  

 
Motion paths are made up of segments. Each Move or Jump automation an object performs 
will create another motion path segment. These segments are connected to form a complete 
motion path. Real-time motion paths are made up of many segments that create complex 
curves. Each motion path can be edited to fine tune its shape and position. The Spatial Audio 
Workstation tools have three modes for editing objects and their paths:  
 

▪ Object Selection 
This is the default mode that the Spatial Audio Workstation opens into.  

▪ Path Selection  
This mode allows you to choose motion paths for editing.  

▪ Motion Path Edit  
You may only enter this mode once a motion path has been selected.  
 

 

Figure 29: Spatial Audio Workstation selection tools 

3.3.1 Path selection  

 
Path selection mode allows you to define a path or a portion of a path for editing. Enable path 
selection in the Spatial Audio Workstation toolbar then click on a motion path. The path will 
turn blue and have black points at its start and end. The black points define what portion of 
the motion path to edit. They correspond to the left and right locators in Nuendo. If you click 
and drag one of these points, you will see the locator move in Nuendo’s timeline. The portion 
of the motion path that remains blue is selected for editing. 
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Figure 30: The motion path selection with locators 

3.3.2 Motion path edit  

 
In order to edit the shape and course of the motion path, you have to select a portion of a path 
and then press the “Motion Path Edit” button in the Spatial Audio Workstation toolbar. The 
selected portion of the path turns from blue to dark yellow and will now display control points 
at the various curves along the path.  
 
Each turn along the motion path has its own control point. Each control point can be adjusted 
freely, changing the shape of the motion path. Simply click and drag the control point to the 
desired location. By moving various control points, the shape of the entire motion path can be 
changed.  
 

Note: You may move more than one control point at a time by selecting multiple points and 
dragging them together.  

 

 

Figure 31: Control points can be moved to change the shape of motion paths 

 
You can insert additional control points to further alter the shape of the path. Place the mouse 
over the path where you want to create a new control point and choose „Insert control point“ 
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from the context menu (right-click). This new control point can be moved as desired to create 
a new turn.  
 
To delete a control point, place the mouse directly over the point and right-click to choose 
Delete from the context menu. You can also select more than one control point by 
shift+clicking multiple points. Simply press the delete key to remove all selected control points 
at once.  
 
Control Point Handles  
In addition to reposition control points, the shape of the path around the point can be 
contoured. Each control point has one or two “handles” associated with it. These handles are 
used to change the shape of the motion path segment around the selected control point. The 
curvature of the motion path changes by adjusting these handles. 
 
In order to access these handles, two or more control points must be selected. White points 
will appear on top of the control point. These can be moved to change the path shape. 
Experimentation is the best way to get a feel for how this works. The figure below shows 
handles that have been moved in such a way as to create a smooth curve around a control 
point. 
 
When a control point is in the middle of a motion path, it will have two handles associated with 
it. Each handle controls the shape of the line on either side of the control point. 
The way that the two handles interact with one another (control point interpolation) can be 
set in three ways:  
 

▪ Corner  
▪ Smooth  
▪ Symmetric  

 

 

Figure 32: Handles modify the shape of the motion path around a control point 
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In order to change the interpolation of handles, first select one or more control points. Then 
press one of the “Control Point Interpolation” buttons found in the Spatial Audio Workstation 
toolbar. 
 

 

Figure 33: “Control Point Interpolation” buttons in the tools palette 

 
Corner Interpolation  
Corner interpolation allows each handle to be manipulated independently. This can create a 
sharp corner or a smooth curving turn as the path passes through the control point.  
 

 

Figure 34: Corner interpolation of handles 

Smooth Tangent Interpolation  
Smooth interpolation forces the handles to remain opposite of each other around the control 
point, creating a smooth path through the point. However, each handle can be stretched 
independently, allowing varied curves on either side of the control point.  
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Figure 35: Smooth interpolation 

 
Symmetric Tangent Interpolation  
Symmetric interpolation is much the same as Smooth except that the handles are linked 
together in direction and length, resulting in symmetric motion path shapes around the 
control point.  
 

 

Figure 36: Symmetric interpolation 

 

3.3.3 Linear and spline motion path segments  

 
Each motion path segment can have either a linear or a spline shape. By default, all motion 
path segments are created as spline segments. Spline segments allow the curving shape as 
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defined by the handles for each control point. A linear segment is a straight line between 
points. Linear segments do not have control point handles.  
 
In order to change a segment from spline to linear, you must select both the starting and 
ending control points that define a segment. Then use the “Linear Segment Interpolation” 
button from the toolbar. You will notice that the handles for those control points disappear in 
the Stage view.  
 
To change back to a spline, use the “Spline Segment Interpolation” button and the handles will 
return. This may be done for several contiguous segments if all the associated control points 
have been selected.  
 

 

Figure 37: The “Linear” and “Spline Segment Interpolation” buttons will change the segment’s 
shape between two control points 

 

3.4 Automation in Nuendo  

 
All three modes of Spatial Audio Workstation automation (Real-time, Jump and Move) create 
automation data that can be viewed and edited in Nuendo. Once you have created the 
automation, right-click on the track in the Nuendo project window and choose “Show All Used 
Automation”. This shows all the Spatial Audio Workstation parameters with automation data 
in the track timeline. When using Nuendo’s Automation Panel (F6), you can press the “Show 
Used” button to display all automation lanes currently active for the Spatial Audio 
Workstation.  
 

 

Figure 38: Show Used automation function on Nuendo’s Automation Panel 

3.4.1 Mono object automation  
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The position of any object in the Stage view is represented in Nuendo as X, Y and Z coordinates. 
Each axis has its own automation lane showing the position of that object over time. In 
addition, all other object parameters have individual automation lanes in Nuendo.  
For Event and Channel Objects associated with mono audio tracks the available parameters in 
Nuendo are:  
 

▪ Volume  
▪ LFE  
▪ Delay (manual and auto) 
▪ Spread  
▪ Distance Dependent Volume Decay 
▪ Distance Dependent EQ Decay 
▪ Distance Dependent EQ Cutoff Frequency 
▪ X-axis value  
▪ Y-axis value 
▪ Z-axis value 
▪ Source Type (point source/plane wave) 
▪ special parameters like OnScreen, Dialog, Aux (depending on the actual configuration) 

 
Upmix Objects have additional automation lanes for dedicated upmix parameters: 
 

▪ Dry/Wet 
▪ Stage Width 
▪ Divergence 
▪ Ambience Gain  
▪ Ambience Front/Rear 
▪ Ambience Delay 
▪ Ambience Low Pass 
▪ Upmix/Original 

3.4.2 Group Object Automation  

 
Group objects have a slightly different list of automation parameters.  
 

▪ LFE  
▪ X-axis value  
▪ Y-axis value 
▪ Z-axis value  
▪ Rotation  
▪ Scale X  
▪ Scale Y  
▪ Volume  
▪ Delay (manual only)  
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The Scale X and Scale Y parameters start with a default value of one (1) and represent a ratio 
of scaling. Values below 1 constrain the member objects closer to the Group Object while larger 
values spread the member objects apart. X and Y scaling has a range of 0-100. 
 

Note: In Nuendo, a scale value of one (1) is very close to the bottom of the automation track 
in the project window. It may look like a minimum value at first glance but if you draw in 
automation points that go to the bottom of the track, all the group members will be 
constrained to the center of that axis.  
Nuendo ignores the status of joined X and Y scales in the Spatial Audio Workstation. If the 
X and Y scales are joined, editing the scale value of one axis directly in Nuendo’s automation 
lane will not cause the other axis to follow the same changes. 

 
 
The Rotation parameter has a default value of 0 degrees (up or north). As that value increases, 
the members of the group rotate around the center in a clockwise fashion until 180 degrees 
whereupon the values become negative and continue from -180 back to zero.  
Please note that as the rotation of a Group Object changes, so do the angles of the scaling axes 
(X and Y). The next figure illustrates how the X and Y axes are relative to the notch seen on the 
Group Object and not to the stage area itself. 
 

 

Figure 39: The X and Y axes of a Group Object rotate along with the member objects of the 
group as the rotation parameter is adjusted. Scaling of each axis will be relative to the rotation 
degree of the Group Object 

 
 
Motion Paths of Group Members  
When objects are joined together with a Group Object, their motion on the Stage view is 
governed by both their individual motion paths and the motion of the Group Object, including 
Rotation and Scaling. If you dissolve a Group Object that contains automation data, a dialog 
will ask if you wish to keep the automation for all the group’s members. If you choose to keep 
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the automation, the motion paths of each member object will be updated to reflect the 
compound motion of both the Group Object and member object to the new path. Even if no 
automation is written but the group changes the static position of the members, the dialog will 
pop up when dissolving the Group Object.   
 
If you choose not to keep the Group Object automation data, each member will revert to its 
own motion path and position.  
 

3.4.3 Audio track modes  

 
By default, newly created audio tracks in Nuendo are in the Channel Mode, thus creating a 
single Channel Object in the Spatial Audio Workstation. You may choose to switch this to Event 
Mode if you want to have multiple Event Objects instead. When switching from Channel to 
Event mode, all motion paths and other automation for the Channel Object is converted into 
Event Object automation for each event on the audio track.  
 

Note: Before you convert Channel Object automation into Event Object automation, you 
must first have audio events on the track. If there are no audio events on the track when 
you change modes, all automation will be lost! Any part of the timeline that does not 
contain audio events will have no automation present when in Event Mode. 

  
Conversely, you can change an audio track from Event to Channel mode. By doing so all Event 
Objects and automations will be converted into one single Channel Object with the same 
automation data. Since Event Objects can also be members of Group Objects, any group 
automation that affects the Event Objects will be consolidated into the new Channel Object 
automation, retaining the correct motion path and position for each audio source.  
To change the mode of one or more audio tracks, follow these steps:  
 

1. Select one or more audio tracks that are routed to an IOSONO output bus.  
Only Spatial Audio Workstation enabled tracks can have their mode changed.  

2. Choose the option under the Project menu, “SAW: Switch selected tracks to Event 
mode” or use the appropriate buttons on the GUI.  
All automation that was applied to the Channel Object will now be applied to the events 
contained in the Audio track. 
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Figure 40: These options allow you to change the mode of selected Audio tracks 

 
3. Check automation lanes to ensure that all automation was transferred correctly.  

If there are no audio events on an audio track that is switched to Event mode, previous 
automation data written in Channel mode will be lost. Parts in between audio events 
will not have automation.  

 
When switching back to Channel mode, only automation from each audio event will be 
transferred.  
 

3.4.4 Altering layers and groups with automation  

 
When altering the composition of layers and groups in the Layers list using the drag and drop 
method, automation data will be affected if an Event Object is moved out of its parent Group 
Object. For example, if an Event Object is moved from within a Group Object on one layer to a 
new layer, a dialog will appear asking if you would like to transfer the Group Object 
automation data including the static position of that Event. Transferring this group data will 
alter the Event’s motion path to reflect any changes made by the Group Object’s static position, 
rotation, scaling and motion path. Additionally, the Group Object’s volume, LFE level and delay 
will be added to the Event Object’s values in the transfer. 
 

http://www.barco.com/
http://www.iosono-sound.com/


Spatial Audio Workstation User Manual 
 

 

Page 47   

 

www.barco.com I www.iosono-sound.com  
 
 
 
 

 

Figure 41: Group automation transfer dialog 

3.4.5 Motion path visibility  

 
With many motion paths, the Stage view can quickly become overcrowded and confusing. 
Therefore the visibility of motion paths can be controlled in four ways:  
 

▪ Path overall visibility  
Available from the menu View - Path visibility, this option will turn off the visibility for all 
motion paths.  

▪ Path playback visibility  
This option makes paths only visible when Nuendo’s transport is stopped. During playback, 
all motion paths disappear.  

▪ Individual path visibility check box in the Layers list  
You can make an individual motion path invisible by un-checking it in the Layers list. Each 
motion path is listed in the Layers list and has both locking and visibility check boxes.  

 

 

Figure 42: Motion path check boxes in layers list 

▪ Motion Path Fading  
Motion path fading allows the Spatial Audio Workstation GUI to only display the portion of 
the motion path that corresponds to the horizontal zoom level (visible part of the timeline) 
in Nuendo’s project window.  

 

 

Figure 43: The “Path fading” button (right most) in the toolbar 

 
Motion path fading is a convenient way to focus on a portion of a complex motion path using 
the horizontal zoom function in Nuendo’s project window.  
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By enabling motion path fading with the button in the toolbar only the portion of a motion 
path in between the left and right boundaries of the project window will be displayed. When 
the cursor continues past those points, the motion path will fade as seen in the figure below. 
 

 

Figure 44: Motion path fading at zoom level 

3.5 Export Nuendo Project 

When a mixing project created with Spatial Audio Workstation is finished export to several 
output master formats in channel-based or object-based configurations is possible. 
 

3.5.1 Export an object-based master file 

 
In case the Spatial Audio Workstation is used in a 3D mixing facility or venue equipped with 
an Barco AudioCue, the plugin is normally working in External Processing mode. Here the 
common method is to export (or print) the mix to IOSONO’s object-based 3D audio format 
(IMF). These files can be transferred to a Barco AudioCue, IOSONO CORE or IOSONO ONE 
audio processor for standalone playback. 
 
IMF – IOSONO MASTER FILE is the advanced export file and combines object audio streams 
(transparent 48kHz, 24Bit) with meta data. 
 
To export an IMF follow these steps: 
 

1. Make a selection (Locator L and R) in the timeline of Nuendo’s Arrangement window. 
This part of the mix will be exported. 

2. Choose Export as IMF from Spatial Audio Workstation’s File menu 
3. Check the export length, file size and channel count in the details view 
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4. Start export 
5. Set a name for the file in the file browser and accept 

 

 

Figure 45: Export object-based audio files 

 

 

Figure 46: Details view for IMF Export 

 
Note: When using the export function for the first time you’re asked to set a Temporary files 
path. Go to Preferences in Spatial Audio Workstation’s Settings menu. Open the Export tab 
and set the path. 
 

3.5.2 Export a channel-based master file 

 
A mixing project created with Spatial Audio Workstation can be delivered as a channel-based 
master (Stereo, 5.1), as well. In this case the project settings must be set to Internal 
Processing mode with the appropriate output assignment. 
 
To export the master file follow these steps: 
 

1. Make a selection (Locator L and R) in the timeline of Nuendo’s Arrangement window. 
This part of the mix will be exported. 

2. Go to Nuendo’s File menu, choose Export and Audio Mixdown. 
3. In the Channel Selection area select the SAW Internal Mix bus. 
4. Set file name and file path. 
5. Choose a file format (i.e. WAV) 
6. Set Samplerate and Bit Depth under Audio Engine Output 
7. Click Export 
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Figure 47: Export Channel-based audio files 

 
The channel order follows the settings of the SAW Internal Mix bus. See VST Connections 
under Outputs (shortcut F4). 
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